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Εξοικείωση με τα Εργαλεία για το μάθημα Τεχνολογίες Εφαρμογών 

Διαδικτύου. 

Χειμερινό 2024-2025 

Ενημερώθηκε στις:  29/10/2024 

Τα βήματα Α1-Α3 μπορούν να υλοποιηθούν με την διαδικασία που περιγράφεται στο αρχείο 

01_ted_install_2024.  Εδώ παρουσιάζονται ενδεικτικά σε περίπτωση που κάποιος δεν μπορεί 

να χρησιμοποιήσει τον αυτοματοποιημένο τρόπο (πχ δεν χρησιμοποιεί Windows όπως τα 

εργαστήριά μας) 

Α1. Λογισμικό που θα χρησιμοποιήσουμε 

[Αυτή η παράγραφος είναι για ενημέρωση για την περίπτωση που θέλετε να εγκαταστήσετε τα 

εργαλεία σε προσωπικό σας υπολογιστή.  Δεν χρειάζεται να κάνετε κάτι κατά την διάρκεια του 

εργαστηρίου. 

1. Εγκατάσταση ενός Java SE Development Kit (JDK).   Θα πρέπει να χρησιμοποιηθεί έκδοση από jdk 

21 και πάνω.   

2. Τον Web Server Apache Tomcat.  Στην τάξη χρησιμοποιούμε την έκδοση 10.1.26 

3. Το περιβάλλον Eclipse για Java EE.  Στην τάξη χρησιμοποιούμε την έκδοση eclipse-jee-2024-06-R 

4. Μια βάση δεδομένων.  Θα χρησιμοποιήσουμε την SQLite (για ευκολία) και αν επιτρέψει ο χρόνος 

και την  MySQL. 

 

Α2. Η δομή των φακέλων στο εργαστήριο. 

[Αυτή η παράγραφος είναι για ενημέρωση δεν χρειάζεται να κάνετε κάτι στο εργαστήριο] 

Στο εργαστήριο έχει δημιουργηθεί η ακόλουθη δομή φακέλων: 

C:\TED 

C:\TED\tools\eclipse    Εδώ έχει αποσυμπιεστεί το zip αρχείο του προγράμματος Eclipse 

C:\TED\tools\apache-tomcat-10.1.26   Εδώ έχει αποσυμπιεστεί το zip αρχείο του Apache Tomcat 

C:\TED\tools\ DB-Browser-for-SQLite  Περιέχεται ένα εργαλείο πλοήγησης σε Βάση Δεδομένων SQLite 

C:\TED\samples  Εδώ έχουν τοποθετηθεί δείγματα κώδικα. 

C:\TED\workspace\eclipse  Περιέχει καταλόγους cli και eclipse. Εδώ θα δημιουργήσετε ένα 

καταλόγους με τον αριθμό μητρώου σας σαν χώροι εργασίας 

C:\TED\workspace\libraries Περιέχει βιβλιοθήκες java (jar files) που θα χρειαστούν στο μάθημα. 

 

Α3.  Δημιουργία χώρου εργασίας 
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Δημιουργείστε ένα φάκελο με όνομα τον αριθμό μητρώου σας μέσα στον φάκελο  

C:\TED\workspace\eclipse  

 

Α4.  Αρχικοποίηση του χώρου εργασίας σας στο Eclipse 

Θα πρέπει να έχετε ήδη εγκαταστήσει έκδοση jdk 21 και πάνω. Αν δεν το έχετε κάνει μην συνεχίζετε. 

Α4.1  Πρώτη Έναρξη του προγράμματος 

1. Ανοίξτε τον φάκελο C:\TED\tools\eclipse και εκτελέσετε το πρόγραμμα eclipse.exe 

Θα εμφανιστεί ένα παράθυρο για να καθορίσετε τον χώρο εργασίας σας (workspace). 

2. Με την βοήθεια του κουμπιού Browse επιλέξτε τον φάκελο που δημιουργήσατε πιο πάνω.  [Για 

παράδειγμα αν ο Αριθμός Μητρώου σας είναι 77777 θα επιλέξετε τον φάκελο:  

C:\TED\workspace\eclipse\77777] 

3. Θα εμφανιστεί μια σελίδα καλωσορίσματος (Welcome) την οποία μπορείτε να κλείσετε πατώντας 

το σύμβολο Χ δίπλα από το Welcome πάνω αριστερά.   Θα εμφανιστεί ο χώρος λειτουργία της 

εφαρμογής. 

Α4.2  Επιλογή της κατάλληλης έκδοσης Java 

Θα πρέπει να διαμορφώσετε το Eclipse να χρησιμοποιήσει μια Java JDK έκδοση (Java Development Kit).  

Συνήθως στους υπολογιστές εγκαθίσταται μόνο η έκδοση Java JRE (Java Runtime Environment) που δεν 

είναι αρκετό για το μάθημα.   

Από την Μπάρα Εντολών επιλέξτε το Window->Preferences.  Θα εμφανιστεί ένα παράθυρο ρυθμίσεων. 

1. Στην αριστερή στήλη εντοπίστε και χτυπήστε πάνω στην περιοχή Java.  Θα εμφανιστούν υπο-

επιλογές.  Επιλέξτε την επιλογή Installed JREs.    Στο αριστερό τμήμα εμφανίζεται η επιλογή Java 

που χρησιμοποιείται.  Παρατηρήστε ότι η επιλογή ξεκινά με jre και δεν είναι η επιθυμητή επιλογή.  

Θα προσθέσουμε την επιλογή jdk… . Θα πρέπει να είναι από 21 και πάνω  

2. Πατήστε το κουμπί Add 

3. Στο παράθυρο που θα εμφανιστεί αφήστε την επιλογή STANDARD VM και πατήστε το Next 

4. Πατήστε πάνω στο Directory για να θέσετε την επιλογή JRE Home.  Επιλέξτε τον φάκελο C:\Program 

Files\Java\jdk-21 ή κάποιο αντίστοιχο. (δηλ να ξενικά με jdk).    Σημείωση!!!  Αν δεν εμφανίζεται ο 

φάκελος Program Files επιλέξτε  «Αρχεία Εφαρμογών» 

5. Στη συνέχεια επιλέξτε Finish 

6. Στο παράθυρο που θα εμφανιστεί επιλέξτε την έκδοση JDK που μόλις προσθέσατε και πατήστε 

Apply and Close. 

Α4.3  Επιλογή επιπέδου προειδοποιήσεων 

1. Από την Μπάρα Εντολών επιλέξτε το Window->Preferences.  Θα εμφανιστεί ένα παράθυρο 

ρυθμίσεων. 

2. Στην αριστερή στήλη κάντε διπλό πάτημα στην λέξη Java  και στην συνέχεια ανοίξτε την περιοχή 

Compiler με διπλό πάτημα. 

3. Επιλέξτε το τμήμα Errors/Warnings  
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4. Στο δεξιό μέρος των ρυθμίσεων ανοίξτε (με διπλό πάτημα) τον τομέα  Potential Programming 

Problems 

5. Εντοπίστε την ρύθμιση Serializable Class without SerialVersionUID  και τροποποιήστε την τιμή της 

από Warning σε Ignore 

6. Επιλέξτε Apply and Close. 

 

Α4.4  Σύνδεση του χώρου εργασίας με τον Apache Tomcat 

 

1. Στο κάτω μέρος του παραθύρου εφαρμογής επιλέξτε την καρτέλα Servers.  Στο παράθυρο θα 

εμφανιστεί ο σύνδεσμος No Servers are available. 

2. Πατήστε τον σύνδεσμο και θα εμφανιστεί ο οδηγός εγκατάστασης ενός Server 

3. Στο εσωτερικό πλαίσιο με κατηγορίες Server ανοίξτε την κατηγορία Apache και επιλέξτε Tomcat 

v10.1 Server 

4. Πατήστε το κουμπί Next  

5. Στο πεδίο Tomcat Installation Directory εισάγετε με την βοήθεια του κουμπιού Browse τον 

κατάλογο όπου βρίσκεται αποσυμπιεσμένος ο server (δηλ.  C:\TED\tools\apache-tomcat-10.1.26 ) 

6. Πατήστε το κουμπί Finish 

[Σημείωση:  Στον φάκελο Apache Tomcat του εργαστηρίου έχουν ήδη δημιουργηθεί δύο τροποποιήσεις 

διαμόρφωσης.  Οι τροποποιήσεις χρησιμοποιούν την θύρα 80 αντί για την 8080 ώστε να είναι 

ευκολότερος ο καθορισμός ενός URL και την αυτόματη εγκατάσταση αλλαγών  ] 

A4.5 Επιλογή Θύρας 80 αντί της 8080 

Κάντε διπλό κλικ πάνω στην γραμμή ”Tomcat v10.1 …” στην καρτέλα Servers. Στο κύριο παράθυρο θα 

εμφανιστεί ένα παράθυρο ρυθμίσεων με τίτλο Overview.  Εντοπίστε την περιοχή Ports στην δεξιά 

στήλη. Αλλάξτε στην γραμμή HTTP/1.1 από 8080 σε 80 και επιλέξτε File->Save. 

Σημείωση :  Δεν είναι υποχρεωτικό να γίνει η αλλαγή ιδιαίτερα αν επιθυμείτε να χρησιμοποιήσετε την 

Θύρα 80 για κάποια άλλη εφαρμογή στον υπολογιστή σας.  Το πλεονέκτημα είναι ότι δεν θα πρέπει να 

χρησιμοποιείται το 8080 σε κάθε URL των ασκήσεών σας. 

A4.6 Αυτόματη ενεργοποίηση αλλαγών  

Η ακόλουθη διαμόρφωση θα σας διευκολύνει να μεταφέρονται οι αλλαγές που κάνετε στα αρχεία 

εφαρμογής αυτόματα στον server ώστε να βλέπετε άμεσα τα αποτελέσματα των τροποποιήσεών σας. 

Ανοίγετε το project Servers στην αριστερή στήλη.  Εντοπίζετε το αρχείο context.xml όπως φαίνεται στο 

σχήμα πιο κάτω.  Ανοίγετε το αρχείο (επιλέγετε την ταμπλέτα Source) και εντοπίζετε το στοιχείο 

<Context> (όπως φαίνεται στην ακόλουθη εικόνα στην γραμμή 18.  Μπορεί να είναι και στο τέλος της 

γραμμής 17.  Το τροποποιείτε σε <Context reloadable="true">, σώζετε το αρχείο και ξεκινάτε πάλι το 

Server. 
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A5   

A5.1   Εισαγωγή ενός έργου (project) 

Θα προσθέσουμε ένα Eclipse Project που περιέχει δοκιμαστικό κώδικα.   

1. Από την Μπάρα Εντολών επιλέξτε File->Import… 

2. Στα παράθυρο που εμφανίζεται επιλέξτε General->Existing Projects into Workspace 

3. Πατήστε το κουμπί Next 

4. Επιλέξτε την περίπτωση Select archive File  

5. Με την βοήθεια του κουμπιού Browse επιλέξτε το αρχείο 

C:\TED\samples\new\test-app-new.zip 

Αν δεν υπάρχει εκεί θα σας το παρέχει το διδάσκων. 

6. Πατήστε το κουμπί Finish 

 

Α5.2  Ρύθμιση Έκδοσης Πλατφόρμας Tomcat. 

Αν μετά την εισαγωγή του project δείτε μια ένδειξη λάθους (ένα μικρό x με κόκκινο φόντο) στο όνομα 

του project σημαίνει ότι το αρχικό project μπορεί να είχε διαμορφωθεί σε κάποιο άλλο περιβάλλον.  

Θα πρέπει να το ενημερώσουμε για την έκδοση Apache Tomcat 10.1. 
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1. Κάντε δεξιό κλικ πάνω στο όνομα του project test-app-new 

2. Επιλέξτε Properties στο τέλος της λίστας επιλογών 

3. Στο παράθυρο που θα εμφανιστεί επιλέξτε Targeted Runtimes  

4. Στην δεξιά πλευρά θα εμφανιστούν δύο επιλογές.  Επιλέξτε το Apache Tomcat v10.1 και 

απoεπιλέξτε αυτό που ήταν επιλεγμένο. 

5. Πατήστε ΟΚ.  Θα παρατηρήσετε ότι το πρόβλημα έχει διορθωθεί. 

 

Α5.3  Εγκατάσταση της εφαρμογής στον Εξυπηρετητή (Server) 

1. Επιλέξτε την καρτέλα Servers στο κάτω μέρος του Eclipse. 

2. Κάντε δεξιό click πάνω στον Server ή στο κενό χώρο πιο κάτω. 

3. Θα εμφανιστεί μια λίστα επιλογών.  Επιλέξτε την λειτουργία Add and Remove… 

4. Στο παράθυρο που θα εμφανιστεί επιλέξτε το project test-app-new στην αριστερή στήλη και 

πατήστε το κουμπί Add 

5. Στην συνέχεια πατήστε Finish 

 

A5.4 Επισκόπηση του project test-app-new 

1. Στη αριστερή στήλη στο περιβάλλον ecliple κάντε διπλό πάτημα πάνω στο έργο test-app-new 

2. Θα εμφανιστεί η δομή αρχείων και πόρων του έργου.  Εντοπίστε τον τομέα Java Resources και 

ανοίξτε τον με διπλό πάτημα (εναλλακτικά μπορείτε να πιέσετε πάνω στο μικρό τρίγωνο) 

3. Με παρόμοιο τρόπο ανοίξτε τον τομέα src/main/java. Στην περιοχή αυτή θα τοποθετείτε τον 

κώδικα Java της εφαρμογής σας οργανωμένο σε πακέτα (packets). 

4. Παρατηρείστε ότι εμφανίζονται δύο πακέτα.  Ανοίξτε το testPackage   με διπλό click.   

5. Εμφανίζεται μια λίστα με τρία αρχεία. 

6. Κάντε διπλό click στο TestServlet.java για να το ανοίξετε.  Θα εμφανιστεί στην κεντρική περιοχή του 

eclipse.   Δείτε τον κώδικα.  Παρατηρήστε τα δομικά συστατικά ενός Servlet.  Εντοπίστε την δήλωση 

@WebServlet η οποία συνδέει το Servlet με τον τμήμα URL /test1. 

7. Στην συνέχεια ανοίξτε τον φάκελο src/main, εντοπίστε τον τομέα webapp και ανοίξτε τον με διπλό 

click.  Στην περιοχή αυτή θα τοποθετούμε στατικά αρχεία html και σελίδες διακομιστή java (jsp) 

8. Εντοπίστε τον φάκελο WEB-INF και ανοίξτε τον με διπλό click.  Παρατηρείστε ότι υπάρχει ένα 

αρχείο με όνομα web.xml.  Αυτό το αρχείο λέγεται Περιγραφέας Εκδίπλωσης Εφαρμογής 

(Application Deployment Descriptor) και χρησιμοποιείται για να καθορίζονται διάφορες 

παράμετροι στον διακομιστή που θα φιλοξενήσει την εφαρμογή.    

9. Ανοίξτε το αρχείο.  Στο παράθυρο που θα εμφανιστεί επιλέξτε την καρτέλα Source (αντί για Design) 

για να δείτε το περιεχόμενο σε μορφή κειμένου.   Δείτε πως γίνεται μια επιπλέον αντιστοίχιση 

(servlet-mapping) του Servlet testPackage.TestServlet με το τμήμα url /test2 

 

Α5.5  Έναρξη Λειτουργίας του Server και Δοκική της Εφαρμογής 

Τώρα θα δοκιμάσουμε να εκτελέσουμε την εφαρμογή που περιέχεται στο project test-app-new 

1. Επιλέξτε την καρτέλα Servers στο κάτω μέρος του Eclipse 
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2. Πατήστε το πράσινο κουμπί με ένα λευκό βέλος στο πάνω δεξιό μέρος της καρτέλας. 

3. Αυτό θα προκαλέσει την έναρξη λειτουργίας του Apache Tomcat Server.  Η εφαρμογή μας έχει ήδη 

εγκατασταθεί εκεί από προηγούμενο βήμα.   

4. Υπάρχει περίπτωση να εμφανιστούν δύο παράθυρα που να ζητούν να δοθούν κάποιες άδειες 

πρόσβασης.  Μπορείτε να πατήσετε το κουμπί  Άκυρο. 

5. Στην συνέχεια θα προσπαθήσουμε να καλέσουμε ένα servlet.  Ξεκινήστε μια εφαρμογή 

Περιήγησης στο Internet (π.χ. Firefox ή Chrome) στον υπολογιστή σας. 

6. Στην θέση της διεύθυνσης εγγράφου εισάγετε http://localhost/test-app-new/test1.  Προσέξτε ότι 

καθορίζουμε σαν Server το localhost που είναι συνώνυμο του υπολογιστή μας.  Στην συνέχεια 

σχηματίζουμε το μονοπάτι δίνοντας το όνομα της εφαρμογής και το τμήμα test1 που είχαμε 

συνδέσει με το Servlet TestServlet μέσω της δήλωσης @WebServlet.   Πατήστε Enter και 

παρατηρήστε ότι θα παρουσιαστεί το αποτέλεσμα που παράγει το TestServlet.java 

7. Μπορούμε επίσης να καλέσουμε τη ίδιο Sevlet αν χρησιμοποιήσουμε το URL http://localhost/test-

app-new/test2 Ο λόγος είναι γιατί συνδέσαμε και αυτό το όνομα με το ίδιο Servlet μέσω της 

αντιστοίχισης στο αρχείο web.xml 

A5.6  Διακοπή της Εκτέλεσης του Tomcat και τερματισμός της εφαρμογής Eclipse 

Για να σταματήσετε τον Tomcat μπορείτε να πατήσετε το κόκκινο κουμπί στην θέση που υπήρχε το 

πράσινο βελάκι. 

 

http://localhost/test-app-new/test1
http://localhost/test-app-new/test2
http://localhost/test-app-new/test2

